
This quick reference guide describes tasks using the Analysis mode in the Thermo TraceFinder™ 5.0 application.

For detailed descriptions of all procedures described in this quick reference guide, refer to the appropriate Analysis 
mode chapter in the TraceFinder User Guide.

 To open the Analysis mode

Click Analysis in the navigation pane.

The Analysis navigation pane opens.

Batch View Use the Batch View to manually create and edit a new batch or open and edit a previously saved batch. When you 
submit a batch, you can acquire data, process data, or create reports for the submitted samples.

 To open the Batch View

Click Batch View in the navigation pane.

The Batch View navigation pane opens.

The Batch View includes the following pages:

• Samples Page (all batch types)

• Auto Samples Page (quantitation batches with intelligent sequencing only)

• Reference Sample Page (quantitation batches only)

• Threshold Samples Page (quantitation batches only)
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Samples Page Use the Samples page to create a new batch. Follow these procedures:

• To open the Samples page

• To create a new batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To copy a sample

• To reinject a sample

• To edit sample values

• To create a group

• To submit samples

 To open the Samples page

Click Samples in the Batch View navigation pane.

 To create a new batch
1. Choose File > New > Batch.

The Create New Batch dialog box opens.
2. Select a repository from the list.

The project list displays all projects, subprojects, and batches in the selected repository.
3. Select the folder where you want to store your batch.
4. Type a batch name in the New Batch box.
5. To select a master method, do the following:

a. Select either Quan, Screening, or Unknown Only from the Type list.
b. Select a repository from the Repository list.
c. Select a master method from the Name list. 

The Name list displays all available methods for the selected method type.
6. Click Create.

A new batch opens with one Unknown sample. The batch name in the title bar indicates that you are creating 
either a quantitation, a target screening, or an unknown screening batch.

 To add samples to the list

Select the number of sample rows to add and click the Add Sample icon, .

The application adds the specified number of new samples to the end of the sample list.

Tip  The application displays all configured and enabled repositories. 

Tip  To activate the Create button, you must enter a unique batch name and select a master method. If the 
Create button is not activated, you have either entered a batch name that is already used or you have not 
selected a master method.

Tip  To add a single sample row, right-click the sample list and choose Add Sample.
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 To insert samples into the list
1. Select the sample above which you will insert new samples.
2. Select the number of samples to insert and click the Insert Sample icon, .

The application inserts the Unknown samples above the selected sample.

 To import samples into the list
1. Click the Import Samples icon, .

The Sample Import Tool dialog box opens.

2. Browse to and select a CSV, an XML, or an SLD file that contains the sample definitions to import.
3. From the Imported Samples Will Be list, select either Appended to the End of the List or Inserted at the 

Selected Row.
4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples to the sample list. 

When you import samples from an Xcalibur™ sequence file, the TraceFinder application makes the following 
column name and sample type substitutions. 

 To remove samples from the list
1. Select the samples that you want to remove.

2. Right-click and choose Remove Selected Samples. 

 To copy a sample
1. Select the sample that you want to copy.
2. Right-click and choose Insert Copy Sample.

The TraceFinder application inserts the copy above the selected sample.

 To reinject a sample
1. In the Sample list, select the sample that you want to reinject.
2. Right-click and choose Reinject This Sample.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to the file name. 
Additional reinjections of the same sample are numbered INJ002, INJ003, and so forth. The TraceFinder 
application copies all parameter values from the original sample.

Xcalibur column TraceFinder column Xcalibur sample type TraceFinder sample type

Position Vial Position Blank Matrix Blank

Inj Vol Injection Volume Std Bracket Cal Std

Dil Factor Conversion Factor

Tip  Use the CTRL or SHIFT keys to select multiple samples.

Inserted samples



4

 To edit sample values 
1. For each sample, do one of the following:

• Type a new file name over the current file name.

• Double-click the Filename column and locate a raw data file to use for the sample. 
–or–

• Right-click and choose Browse in Raw File, and then locate a raw data file to use for the sample.
2. For each sample, click the Sample Type column and select a sample type from the list.

3. For each Cal Std or QC sample, select a level from the Level list.

The sample levels are defined in the master method. If there are no levels to select from the Level list, do the 
following:
a. Return to the Method Development mode.
b. Open the method.
c. Click the Compounds tab.
d. Click the Calibration Levels tab.
e. Add the levels.
f. Save the method.
g. Return to the Analysis mode, and then click Update.

The application updates the local method with the new sample levels.
4. (Optional) Enter or edit the values for the remaining columns.

 To create a group
1. For each sample, click the Groups column and type the name of a group.
2. Repeat step 1 for each sample that you want to include in a group.
3. Create as many groups as you want. 

 To submit samples
1. Do one of the following:

• To submit all samples in the batch, click the Submit Batch icon, .
• To submit specific samples, select the samples and click the Submit Selected Samples icon, .

The Submit Options dialog box opens. 
2. To acquire (or reacquire) the submitted samples, select the Acquire Data check box.
3. To process the submitted samples, select the Process Data check box.

The application displays options for the type of method that the batch uses: Quantitation, Target Screening, or 
Unknown Screening. If a quantitation method or target screening method includes unknown screening features, 
the application also displays unknown screening options.

Available sample types

Matrix Blank Solvent QC Unknown Cal Std

Note  When you use the scroll bar at the bottom of the sample list, the following columns remain fixed: 
Status, Filename, Sample Type, Groups, Qual Processing (quantitation) or Blank Subtraction (target 
screening) Level, Sample ID, and Sample Name, while the other columns scroll right and left. 

Note  To assign a sample to multiple groups, separate the groups with a comma. 
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4. Select the check box for the options that you want to use.
Peak Detect: Performs peak detection for all method types. You can process the data with or without performing 
peak detection. For example, you might want to turn off peak detection when reprocessing samples.
Quantitate: Performs quantitation.
Identify: Performs identification for unknown screening.
Identify and Confirm: Performs both identification and confirmation for target screening.
With RT Alignment: Performs retention time alignment for unknown screening. This produces the heat map 
and group averages data in the Unknown Screening View. 

5. (Optional) Select the Create Reports check box. 
6. To start the selected processes, click OK. 

Auto Samples
Page

The Auto Samples page identifies the Solvent or Matrix Blank samples to use for any Auto Sample or Auto Sample 
and Reinject failure actions as specified on the Intelligent Sequencing page of the method. 

 To open the Auto Samples page

Click Auto Samples in the Batch View navigation pane.

The Auto Samples page opens. 

 To add an auto sample type
1. Right-click and choose Add Auto Sample from the menu, or click the Add New Auto Sample icon, .

The application adds a Solvent sample to the sample list.
You can add, insert, or remove samples from this list as you would any sample list. See Samples Page.

2. To change the sample type to a Matrix Blank, click the Sample Type column and select Matrix Blank from the 
list.

3. In the Injection Volume column for the sample, type a volume.
The minimum injection volume value allowed is 0.1 μL; the maximum injection volume value allowed is 
5000 μL.

4. In the Number of Injections column, type the number of injections available in the designated Solvent or Matrix 
Blank vial.
After auto sample injections have occurred, you can return to this page to view the number of injections used in 
each vial.

5. In the Vial Position column, type the vial position for the Solvent or Matrix Blank sample. 

Reference
Sample Page

The Reference Samples page displays the reference samples selected for this batch.

 To specify a chromatogram reference sample
1. Click Reference Sample in the Batch View navigation pane.

An empty reference sample table opens.

2. Right-click the table and choose Add Reference Sample, or click the Add Reference Sample icon, .
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The Open Chromatogram Reference Sample dialog box opens.

3. Select a project from the list of projects.
4. Select a subproject from the list of subprojects.
5. Select a batch from the list of batches.

The application displays only batches that were created using the current master method. 
6. From the right panel, select a sample from the list of processed samples.

The application displays all the processed samples in the selected batch. Before using a sample as a reference 
sample, you must have processed the sample with the current master method.

7. Click Open.

Threshold
Samples Page

For each group in a batch, you can specify a sample in the group as the threshold sample to use in the Comparative 
View.

 To specify a threshold sample
1. In the navigation pane, click Threshold Samples.
2. Open the Sample list for each group and select a sample in the group to be the threshold sample.

The Comparative View uses the threshold method and amount you specified in the method, the group you created 
on the Samples page, and the threshold sample that you selected on this page to define the threshold guide that it 
displays on the sample peak plots.

See also To create a group and Comparative View.

Data Review Use Data Review to verify the data generated by a quantitation, a target screening, or an unknown screening master 
method before you generate reports.

• Data Review for Quantitation Batches

• Data Review for Target Screening Batches

• Data Review for Unknown Screening Batches

 To open the Data Review view

Click Data Review in the navigation pane.

Note  If you are using a new method, no reference samples appear here. You must first process a batch using 
the current method to see the reference samples in this list.

Data Review for quantitation batches Data Review for target screening batches Data Review for unknown screening batches
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Data Review
for

Quantitation
Batches

The Data Review for quantitation batches includes the following:

• Survey Mode

• Sample View

• Compound View

• Comparative View

• Qualitative View

Survey Mode

Whether you are assigned strict or loose Survey View permission, only Cal Std and QC sample types are displayed 
during processing; and the Sample View, Compound View, and Comparative View headers show Survey Mode or 
Survey Mode - Loose Restrictions, respectively. If you are assigned loose Survey View permission, however, all 
sample types are available to you after processing is completed.

Sample View
 

The Sample View displays a list of all samples in the current batch (Samples pane), the compound results for all 
compounds in the method (Compound Results pane), and peak plots for all compounds found in the currently 
selected sample (Sample-centric Plot pane). 

• Samples pane

Use the Samples pane to select a specific sample. The associated Compound Results pane displays all 
compounds in the method and flags any compound with errors in the selected sample.

• Compound Results pane

Use the Compound Results pane to select a specific compound in the selected sample. The associated 
Sample-centric Plot pane highlights the selected compound.

Note  If the quantitation method for the batch includes unknown screening features, the Data Review also 
includes an Unknown Screening View. See Data Review for Unknown Screening Batches.

Tip  (Animation) To view “Using the Sample View,” choose Help > Animations.

Selected sample No compound error in the selected sample

Compound error in the selected sample
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• Sample-centric Plot pane

The Sample-centric Plot pane displays the chromatogram, retention time, area, height, and signal-to-noise ratio 
for each compound in the Compound Results pane. The application highlights the chromatogram for the 
compound that is currently selected in the Compound Results pane.

 To display details for a compound

Double-click the chromatogram in the Sample-centric Plot pane.

The Compound Details pane displays information about the Quan Peak, Confirming Ions, Reference Peak, 
ISTD, Ion Overlay, Calibration Curve, Spectra, Library Match, Isotope, Fragments, and Quan Peaks 
Overlay for the compound. 

Quan Peak

A compound can have multiple quantitative peaks. You can switch between quantitative peaks, but you cannot 
view multiple quantitative peaks at the same time. 

Confirming Ions
Figure 1. Quantitative peak with multiple confirming ions

Note  For compounds with an analog detection type, the application displays “No Confirming Ions Are 
Enabled” in the Confirming Ions pane.



9

Reference Peak
Figure 2. Quantitative peak with a reference peak

ISTD
Figure 3. Quantitative peak with an internal standard

Ion Overlay
Figure 4. Quantitative peak with a confirming ion overlay

Note  For compounds with an analog detection type, the application displays “No Data.”
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Calibration Curve 
Figure 5. Quantitative peak with a calibration curve plot

Spectra
Figure 6. Quantitative peak with data and reference spectra

Library Match
Figure 7. Quantitative peak with a library match

Note  For compounds with an analog detection type, the application displays “Not Available.”
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Isotope
Figure 8. Quantitative peak with isotopes

Fragments
Figure 9. Quantitative peak with fragments

Quan Peaks Overlay
Figure 10. Quantitative peak with a quan peaks overlay
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Compound View
 

The Compound View displays a list of all compounds available in the method (Compounds pane), all samples in the 
current batch (Sample Results pane), the peak plots for all compounds found in each sample (Compound-centric 
pane), Group Averages pane, and a Retention Time Summary pane.

• Compounds pane

Use the Compounds pane to select a specific compound. The Sample Results pane displays all samples in the 
batch and flags any sample that contains errors associated with the selected compound.

• Sample Results pane 

Use the Sample Results pane to select a compound in a specific sample. The Compound-centric Plot pane 
highlights the selected compound and displays the name of the sample in which the compound was found and 
the following information about the compound: the chromatogram, retention time, area, height, and 
signal-to-noise ratio. 

• Compound-centric Plot pane 

Use the Compound-Centric Plot pane to view an overlay of the quantitation and confirming peaks for each 
sample in the batch. The Compound-Centric Plot pane displays the compound chromatograms for the selected 
compound in each sample in the batch. A blue border indicates the compound in the sample that is currently 
selected in the Sample Results pane.

Tip  (Animation) To view “Using the Compound View,” choose Help > Animations.

Selected compound No error found in the selected 
compound in these samples

Error found in the selected 
compound in this sample



13

• Group Averages pane 

Use the Group Averages pane to compare the peak areas of different samples to a control group of samples. You 
must define at least two groups, and one group must be a control group. 

• Retention Time Summary pane 

Use the Retention Time Summary pane to view variations of the retention times for a compound across all 
samples in a batch. The Retention Time Summary pane displays each color-coded compound for each sample in 
the batch. 
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Comparative View
 

The Comparative View uses three panes to display a list of all compounds available in the method (Compounds 
pane), all samples in the current batch (Sample Results pane), and the sample peak plots for all compounds found in 
the samples (Sample-centric Plot pane) with the horizontal threshold guide.

The Comparative View uses the threshold method and amount that you specified in the method, the group that you 
created on the Samples page, and the threshold sample that you selected on the Threshold Samples page to define 
the threshold guide that it displays on the sample peak plots.

Tip  (Animation) To view “Using the Comparative View,” choose Help > Animations.

Horizontal guide indicates 
the threshold value as 
specified in the method.
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Qualitative View

The Qualitative View displays qualitative information for the selected sample. To see processed data for a sample, 
you must select the Qual Processing parameter for that sample in the Batch View before you process the batch. 

The Qualitative View displays a list of all samples in the batch (Samples pane), a list of all peaks in the selected 
sample (Peaks pane), the chromatogram for the selected sample (Sample Chromatogram pane), the chromatogram 
for the selected peak (Peak Chromatogram pane), the reference spectrum and spectrum data for the selected sample 
(Spectrum pane), and the best library matches for the selected peak (Library Hits pane).

• Samples pane

Use the Samples pane to select a specific sample. 

When you select a sample in the Samples pane, the associated Peaks pane displays all peaks found in the sample.

• Peaks pane

The Peaks pane works with the Samples pane to display graphical values for a unique sample and peak 
combination.
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• Sample Chromatogram pane

The Sample Chromatogram pane displays all peaks in the selected sample. The peak selected in the Peaks pane 
displays a red marker.

• Peak Chromatogram pane

The Peak Chromatogram pane displays the selected peak. 

• Spectrum pane

The Spectrum pane displays the reference spectrum from the library and the spectrum data for the selected 
sample. The top pane displays the spectrum for the identified compound found in the reference library; the 
bottom pane displays the actual spectrum data for the selected peak.

• Library Hits pane

The Library Hits pane displays the best library matches for the selected peak. Use this pane to select a different 
library entry for the peak. 

Reference spectrum from 
the library

Actual spectrum data for 
the compound
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Data Review
for Target

Screening
Batches

In the target screening display, the application displays a list of all samples in the current batch, the compound 
results for all compounds in the method, and chromatogram and spectrum plots for all compounds found in the 
currently selected sample. 

The Target Screening View displays a list of all samples in the batch (Samples Pane), a list of all compounds in the 
selected sample (Compounds Pane), the chromatogram for the selected peak (Chromatogram Pane), and the 
reference spectrum and spectrum data for the selected sample (Spectrum Pane).

Samples Pane

Use the Samples pane to select a specific sample in the batch. The associated Compounds Pane displays all 
compounds in the method and flags any compound with errors in the selected sample.

Flags in the Samples pane indicate the following:

(green circle): The sample/compound/peak combination is identified and fully confirmed.

(yellow triangle): The sample/compound/peak combination is identified but not fully confirmed.

(red square): The sample/compound/peak combination is not identified.
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Chromatogram Pane

Use the Chromatogram pane to display all extracted chromatograms of all adducts of the selected compound.

The first tab displays the most intense target adduct for the peak result. Additional (optional) tabs display extracted 
ion chromatograms for other adducts for the target compound at the same retention time in order of intensity. If no 
signal exists for an adduct, the first tab displays the XIC of the expected m/z within the specified retention and 
chromatogram windows. When you do not specify a retention time or window, the application displays the full time 
range. 

Compounds Pane

The Compounds pane displays all found peaks in the selected sample and flags any compound with errors. The 
Target Screening Results grid reflects the identified compounds found in the compound database and the results of 
the method processing criteria.

Spectrum Pane

Use the Spectrum pane to display the spectrum, isotopes, fragments, and library search information for the selected 
adduct in the Chromatogram pane. The Spectrum pane displays only the identification and confirmation criteria 
specified in the method. The confirmations are based only on the most intense adduct.

The Spectrum pane includes the following pages of information (when available) for each selected 
sample/compound/peak combination:

• Spectrum

The application displays the neutral loss (NL) and compound/peak name information on the right side of the 
Spectrum page. When data is available, the plot width is the full mass range in the raw data file. Otherwise, the 
application scales the width to the scan range.
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• Isotopes

The isotopes page displays isotopic pattern results according to the threshold and deviation parameters defined 
in the screening method. To identify or confirm the presence of a compound, the resulting score percentage from 
isotopic pattern matching must be higher than the specified fit threshold percentage. An isotope peak is not 
found if its intensity, relative to the monoisotopic ion’s intensity, is more than the specified intensity deviation 
percentage away from the theoretical relative intensity of the isotope ion. An isotope peak is found if its 
measured m/z is less than the specified mass deviation amount away from its expected m/z. 

• Fragments

The Fragments page displays the maximum number of fragments as specified in the screening method. You must 
define fragments in the screening library.

Measured spectrum Expected spectrumExpected m/z of the isotope
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• Library

The Library page displays the matching library spectrum (in blue) and the experimental spectrum (in black). 
The resulting score percentage from a library search match must be higher than your specified threshold value to 
identify or confirm the presence of a compound. 

The application scales both the matched library spectrum and the highest peak in the measured spectra at 
100 percent intensity and displays the resulting neutral loss (NL) value for the matched library entry name to the 
right of the plot. 

Data Review
for Unknown

Screening
Batches

In the unknown screening view, the application displays the following panes: 

• Cross Sample Peak List Pane

• Heat Map Pane

• Sample List Pane

• Spectrum Pane

• Peak List Pane

• Peak Identifications Pane

• TIC Chromatogram Pane

• XIC

• Peak Chromatogram Pane

• Chemical Structure Pane

• XIC Overlay Pane

• Group Averages Pane

• Cross Sample Peak Overlay Pane

• Library Search Pane

• Fragments Pane

• Isotopes Pane
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Cross Sample Peak List Pane

Use the Cross Sample Peak List pane to compare peak values across all samples in a batch.

Heat Map Pane

Use the Heat Map pane to display the response of each peak occurrence in the batch. The Heat Map pane displays 
all MS Area values for all peaks in all samples in the batch that are above the peak threshold value specified in the 
method. When you select a peak in the Heat Map pane, the application displays the associated results for the 
selected peak in all panes of the Unknown Screening view.

Sample List Pane

Use the Sample List pane to select a sample of interest. The application displays the associated results for the selected 
sample in all panes of the Unknown Screening view.
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Spectrum Pane

When data is available, the plot width is the full mass range in the raw data file. Otherwise, the application scales the 
width to the scan range.

Peak List Pane

Use the Peak List pane to select a specific peak found in the selected sample. The Peak List displays each peak that 
the application identified in the sample.

Peak Identifications Pane

Use the Peak Identifications pane to display the name and formula for identified peaks and the source of the 
identification.
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TIC Chromatogram Pane

Use the TIC Chromatogram pane to display the relative intensity of a trace along the length of the sample data 
retention window.

XIC

Use the XIC pane to display the absolute intensity of an extracted trace along the length of the sample data retention 
window.

Peak Chromatogram Pane

Use the Peak Chromatogram pane to display the selected chromatogram peak. Initially this Peak Chromatogram 
pane displays the apex scan for the detected peak. You can manually integrate the peak and use the updated peak to 
generate reports.

Chemical Structure Pane

Use the Chemical Structure pane to view the chemical formula and structure for the peak that is currently selected in 
the Peak List pane. The application displays the chemical formula (and CAS number when available) from the 
search database that you specified in the method. 
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XIC Overlay Pane

Use the XIC Overlay pane to view specific groups of peaks. You can choose to view all peaks, selected peaks only, or 
the top twenty most intense peaks (by area). The XIC Overlay plot is a collection of overlaid, extracted m/z ion plots 
that use a different color for each peak. 

Group Averages Pane

Use the Group Averages pane to compare the peak areas of different samples to a control group of samples.

Cross Sample Peak Overlay Pane

Use the Cross Sample Peak Overlay pane to compare instances of a selected peak across all samples in the batch. The 
application overlays all occurrences of the peak in the batch. The application displays the names of all samples in the 
batch where the selected peak is found. Samples that are assigned to groups are color coded, and the peaks found in 
those samples are color coded in the plot.
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Library Search Pane

The Library Search pane displays the best library matches for the selected peak, with the highest score listed first.

Fragments Pane

The Fragments pane displays the maximum number of fragments as specified in the unknown screening method. 
When a compound database search returns a match for a peak that has fragments, the Fragments pane displays the 
theoretical fragments. When the data has an MS/MS element that is identified as belonging to the chromatographic 
peak, the Fragments pane displays the fragments found in the MS/MS scan.
Figure 11. All fragments

Figure 12. Individual fragment

Measured spectrum in redExpected spectrum in blue

Intensity threshold specified 
in the method

Measured spectrum in redExpected spectrum in blue
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Isotopes Pane

The isotopes pane displays isotopic pattern results for all adducts of a compound according to the threshold and 
deviation parameters defined in the unknown method. To identify or confirm the presence of a compound, the 
resulting score percentage from isotopic pattern matching must be higher than the specified fit threshold percentage. 
Figure 13. Isotopes pane with overlaid spectra for all isotopes

Figure 14. Isotopes pane with overlaid spectra for multi-isotopes

Figure 15. Isotopes pane with overlaid spectra for a single isotope

Measured spectrum in redExpected spectrum in blue

Expected spectrum in blue Measured spectrum in red

Measured spectrum in redExpected spectrum in blue
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Report View The Report View displays example reports for the current batch. You must have an open batch to use the features in 
the Report View. Follow these procedures:

• To open the Report View

• To preview a report

• To generate a report as a PDF, an Excel™, or a CSV file

• To print a report

• To display a generated report

• To edit a report template

• To create a new report template

 To open the Report View

Click Report View in the navigation pane.

The application opens the Report View. 
Figure 16. Report View

The Open and New buttons open the Report Designer. For details about using the Report Designer, refer to 
“Working in the Report Designer” in the TraceFinder User Guide.
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 To preview a report
1. In the Template pane, select a report template.

The template list shows all the report templates that you configured in the Configuration console. 

2. Click Preview, .

The application opens the Report Designer, showing the report information for the current batch in the selected 
report template format.

 To generate a report as a PDF, an Excel™, or a CSV file
1. In the Template pane, select a report template.
2. Select the check box for each of the file types that you want to create: PDF, Excel, or CSV.
3. Click Generate, .

The application does the following:

• Displays a green progress bar as it generates the reports.

• Creates a report with the selected report template as a PDF, an Excel, or a CSV file.

• Adds information about the generated report to the Generated Reports pane.

• Saves the report files to the …\TraceFinderData\Projects\…\batchname\ReportOutput folder.

 To print a report 
1. In the Template pane, select a report template.
2. Select the check box for the Print file format.
3. Click .

The application does the following:

• Creates a report for the current batch using the selected report template format.

• Prints the report to your default printer.

• Adds information about the generated report to the Generated Reports pane.

• Saves the report files to the …\TraceFinderData\Projects\…\batchname\ReportOutput folder.

 To display a generated report

In the Generated Reports pane, click View for the report that you want to see.

Opens the generated file.
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 To edit a report template
1. In the Template pane, select a report template.
2. Click Open, .

The application opens the Report Designer showing the template in an Excel spreadsheet.

3. Use the features in the Report Designer to edit the template.

 To create a new report template
1. Click .

The application opens the Report Designer showing an empty template in an Excel spreadsheet.
2. Use the features in the Report Designer to create the template.

Local Method
View

In the Local Method view of the Analysis mode, you can edit only the local copy of the method, or you can edit the 
master method and overwrite the local copy with the edited master method. A local method is a copy of a master 
method associated with a batch. Editing the local method does not affect parameters in the master method.

 To open the Local Method view

Click Local Method in the Analysis navigation pane.

The Acquisition page of the Local Method View opens. The Acquisition pages are different for quantitation 
methods, target screening, and unknown screening methods. See Local Method View for a quantitation method, 
Local Method View for a target screening method, or Local Method View for an unknown screening method.

From the Local Method view, access the method parameters just as you would for a master method.

Local methods are named BatchName_MasterMethodName. 

 To edit a local method
1. Enter any changes to the local method. 

To edit a method, refer to the method development chapters in the TraceFinder Lab Director User Guide.
2. Choose File > Save.
3. To process the batch or create new reports with the edited local method, return to the Batch View and submit 

the batch.

 To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.

The application overwrites the local method with the master method of the same name. You can use this feature 
to overwrite an edited local method with the original master method or to overwrite the local method with an 
updated master method. 
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Figure 17. Local Method View for a quantitation method

Figure 18. Local Method View for a target screening method

Figure 19. Local Method View for an unknown screening method

Trademarks TraceFinder is a trademark and Xcalibur is a registered trademark of Thermo Fisher Scientific Inc. in the 
United States. 

Excel and Microsoft are registered trademarks of Microsoft Corporation in the United States and other countries.
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